Zedmed v37.7.5

Last Modified on 08/01/2025 9:32 am AEDT

Import results error

Clinical |ZED-10025 | _. . . . . .
Fixed an issue that prevents loading some incoming documents into Zedmed.

Zedmed v37.7.4

Changed AIR screen to add Other and remove State and Private
Clinical | ZED-9887 | Replaced State and Private options for Vaccine Type with Other to comply with changes to AIR reporting
requirements.

Zedmed v37.7.3

Bank List not completely displayed

Office | ZED-9980 . . . . . . . . .
Fixed the issue where not all Banklists were being displayed in the Practice Details > Bank Accounts dialog

Zedmed v37.7.2

Other fixes and enhancements

Add filter for category Payment Details Link to the Message Manager

Office | ZED-9905 . . S
Messages in the Message Manager can now be filtered on the Payment Details Link category.

Reduce the Appointment Grid Blue line refresh to every 60 seconds
Office |ZED-9914 | Therefresh rate of the current time indicator on the appointment grid has been reduced from half a second
to once per minute to reduce unnecessary resource use.

Zedmed v37.7.0

Payment Gateway enhancements

SMS functionality
You can now SMS patients a link to collect Credit Card information. The SMS can be sent when you close the Appointment Details
screen or from an appointment in the Appointment Grid.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Appointment Details L

Date Tuesday, 19 November 2024
Created by  Office Admin on 19/11f24at 11:32 I
Doctor Phillip Davis Black, Emma ]
Resource E
S el 1115 T ——— . Fiene 62 aull File Yes DOB 13/12/1562 B
Firstin Lastin Type
Duration 00: 10 ¥ Status Curent E
Contact Details
EndTime 1135 & Type |StdConsutation “|  Phone ) work (W) T
Mobie |
Motes a
Address 30 3rd Strest, ELLEN GROVE 4078 £
Other Detais ~—
Expiry MC HEC
v
Reason for chosen date 3
Clirical Warnings
Cancellation Waiting Priority ~
Hide Notes [0 Alowsms [ Send Confirmation SMs ()
Account Payers Select down arrow =
[ Bad, emma 3 500 ] Request Payment Card

when making a booking

Repeated booking O
Print Label Bookingrules  Printletter | e} Find Patient Print Slip

-

[ —
Add (Patient)

i Add (Mon-Patient)

Add (From Cancellation Waiting List) Cirl+W
Details

Edit

Delete

Reguest Payment Card

Patients will open a link in the SMS to a credit card information collection page.

Add new card:

Card Holder Name

Card Number

Expiry Date Security Code (CVV)
‘ vt YY

To verify your card details, a AU$S1
temporary authorisation charge will be
placed on your card. This is temporary
and will be removed from your
statement.

Add Payment Method

Once credit card information is collected, it will be saved and can be used to bill for this and future consultations.
e Acredit card icon on the right means the patient has a valid credit card on record.
e A $iconon the left means the patient has made a credit card payment for that appointment.

Displaying cards and payments

Patient Records now include a Payment Cards tab. Only a Zedmed Administrator can use the Remove function - or a Zedmed account
with the Patient Details - Payment Card (Edit) function.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



#4 Black Emma %
AccEnquiry Attend  Bill  Letters Clinical Information Print Quote Receipt Waiting Room Appointments Extras

Fatient Details Payment Cards

Further Details Card Type Card Number Expiy  Valid
Recalls MASTERCARD | 00002000 X)00( 0008 C013e o
Motepad

eHealth

Messages
mE T
Fayment Cards

Remove

Deleta Print. Fatient Verification Find Close Cancel

Prepayments

You can now take prepayments using credit card information collected using Payment Gateway.
1) Select Receipt on the Patient's Record

2) Enter the Banklist and Amount, then select Payment.

3) Use the ePayment screen to select Bill for the shown/selected credit card.

When you bill, select Credits to apply the deposit, then use ePayment, which will automatically determine the amount due.

Tea Jones, Happy
AccEnquiry Attend  Bil Letters  Clinical Information  Print [‘wte

Waiting Room  Appointments  Extras

e e L Persanal _ Practice
- Family Name Jones Filew 22 PullFile @

Further Details -

Recalls Given Name Happy Intial  Hosp.URNe Clinical Wamnings
Notepad Preferred Name Farmer Usual Branch Branch 1 [22) hd
Receipt Payment

22 Mr Happy Jones

Fatient Family Fatient Family Credits

Payer  lones, Happy ~  Due 0.00 0.00 Deferred 0.00 0.00 20.00

Payments
Format Mame Bank Branch Detail Banklist __Amount

v P v 20.00

1. Cash 2 Cheque 3. MC Cheque Tyro Eftpos l ePayment I Add hange
4. Card 5, Eftpos 6, Direct Depaosit 7. Credits Tyro EasyClaim

Payment Total 0.00
() Family Due 1O Fatient Due Amount Due 0.00 |
Balance 0.00

Other Payment gateway updates

L]

The credit card (token) is now associated with the patient and not just an appointment.

If multiple cards are recorded for a patient, you can select a preferred card in QuickPay by clicking ePayment.

Family/NOK account payer cards are listed when billing. E.g. A credit card captured for a parent can be used to bill the child.
You can part-pay through ePayments and use other payment methods on the same receipt.

(]

(]

(]

Branch Selector for billing

You can now change the branch when billing directly from a patient's record. The invoice will use the treating doctor's provider
number and letterhead for that branch. This means you do not need to log into another branch to use the correct provider number.
You cannot change the branch if you bill from the Appointment Grid or Waiting Room or a patient record opened from there - the
branch will be locked to the branch the appointment was created in.

When you are not billing from the Appointment Book, Zedmed checks for an appointment that matches the branch and doctor. If it
finds one, it uses that attendance for the invoice, and if it does not, it creates a new attendance (without a booking).

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



New Inveice

Invoice

Patient Wr Happy Jones DVA HEow Safety Pens. Status None
File 22 DOB 4/12/1964 (53
Payer Debts = =
Payer Jones, Happy < Add/Edit Payer Patient Family Creait
- Due 0.00 0.00 0.00
Applicable Fee Type Pl
Deferred 0.00 0.00
Branch Apostro’sand ik
Fund Details
Doctor Davis, Phillip v Fund # Fund Fee Type
Te Starts Mthe  Notes Refund/Gap Calculation Invaice Style
Reguest/ o 7 | ) Fund O Medicare Print Gap [_) Corporate [_]
Referral Dr
Services
Date Item# Description Fee Tax Unit Value  Ofy Amount Notes Estim. Refund Gap
1911/2024 | [P | 0.00 0.00 0.00 0.00

Properties Add Change Delete

Doctor Assigned Billing Codes

Billing Instructions

Easydaim ECLIPSE MA Online Bulk Bill

Defer Family

Combao Inv.

Total

Message

Send Medicare Bulk Billing Consent

Print Send to Patient | v Cancel

Suppres Quick Pay Help

e By default, the branch selected is the branch associated with the appointment being billed.

e |fyou change the branch, the available doctors will update to those set up for that branch, even if they don't have appointments

that day.

e To change the branch of an existing invoice, you need to void the invoice and create a new one.

Date stamp for Patient Details notes

The Notes tab in the Patient Record (Office) now has an icon that adds the date and username. This allows staff to date stamp each

entry made in notes.

¥4 Jones, Happy

Bill  Letters Clinical Information  Print

“) | e arial

Acc Enquiry  Aftend
Patient Details i=h
Further Details 19/11/2024 - Office Admin note goes here|
Recalls

Motepad

eHealth

Messages

Payment Cards

Delete Print Patient Verification Find

Quote Receipt

HBIU

Waiting Room  Appointments  Extras

~ |9

Close

Cancel

Other fixes and enhancements

Tyro Eftpos Relnitialisation not working for Quick Pay
Improved the performance of forms that interact with Tyro (invoice and payment forms) when the Terminal

Office |ZED-9801 . . . . . .
Adapter is not yet installed (cloud only). This does not change the time required for the terminal adapter to
install.
Improve the message displayed when attempting to delete a bank list that has transactions

Office ZED-9635 | When trying to delete a bank list (account) with transactions recorded against it, a more meaningful message

is now displayed.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Improved the Expiring Referral report performance.

Office ZED-9724 | Substantially improved performance of Expiring Referrals Report when there are lots of appointments in the
database.
Enable the launching of Waiting Room from patient details when the Appointment Grid is open

Office | ZED-9870 | Users can now navigate to the Waiting Room directly from Patient Details when it is being shown on top of
the Appointment Grid.
Fixed Error "Command text must not be empty"

Office |ZED-9782 | Fixed the issue that caused the error "Command text must not be empty" when clicking on Re-Merge in the
Patient Merge History dialog.

- Removed full stop from the Bulk billing consent SMS

Clinical |ZED-9874 . . - .
Full stop following URL in Bulk Billing consent SMS message sent to patients has been removed.
Improve the message displayed when previewing a Shared Health Summary

Clinical |[ZED-9641 |A more meaningful message is now displayed when attempting to upload a Shared Health Summary that
contains a procedure without an onset date defined.
Fixed issue with preprinted paper types printing multiple copies

Clinical |ZED-9744 |Address Book: Fixed issue with preprinted pathology/radiology referrals printing number of copies equal to
number of tests requested.
Improved the message displayed when previewing a Shared Health Summary

Clinical [ZED-9784 | A more meaningful message is now displayed when attempting to upload a Shared Health Summary that
contains an immunisation without a date given defined.
Resolved complications encountered when MHR finds duplicate of a patient's IHI
When opening a patient record with a duplicate IHI, the MHR Status now displays My Health Record

Clinical [ZED-9829 |available. If the MHR button is clicked, the warning message regarding the duplicate patient demographics or
duplicate IHI is still displayed, however after clicking OK the MHR dialog now opens. This change may also fix
an AV error that is displayed when attempting to upload medication information to My Health Record.
Fixed rrror "Software error. Incorrect update count.”

Clinical | ZED-9835 Fixed an error that occurs when a user tries to “print referrals and close” while they have an unsaved referral

ini -

letter open in the letter writer. The error caused Clinical to freeze. The system will now prompt the user to
close the letter writer.

Zedmed v37.6.0

Fixes and enhancements

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Office

ZED-9698

Add ePayment as a Method on the Refund dialog
ePayment has been added as a refund payment method in Zedmed.

Refund X

Refund amount 71.30 Bank list  Albert Road MC Bank Account =

Method

() cash (C) Cheque () Eftpos () ePayment

A cash refund will A refund cheque will be An EFT refund will An ePayment refund
appear on your treated as a negative appear on your will appear on your
banking reports as a DIRECT DEPOSIT s0 as banking reports as a banking reports as a
negative cash not to affect your negative EFT amount. negative ePayment
amount. banking. amount,

‘Warning: This refund will affect the total amount received on the transaction report of the original receipt
date. You should reprint that transaction report if this was in the past.

Details |

oK Cancel

Office

ZED-9650

Option to disable Easyclaim in billing if Medicare is the Payer
A new option has been added to Practice details to allow disabling of the EasyClaim button when billing a
patient where Medicare is the payer.

Office

ZED-9844

Editing a bank name when there are unavailable bank accounts renames the wrong bank list.
Fixed an issue when changing a banklist name resulting in the wrong banklist being changed.

Office

ZED-9840

Tyro ePayment report only shows ePayments
Tyro ePayment reports have been updated to remove other payment types. It now only includes ePayments.

Clinical

ZED-9834

Document preview updates when an arrow key is used to select the next document
When using the arrow keys to change the selected document or referral, the preview pane is now refreshed
with the currently selected document.

Clinical

ZED-9837

Fixed the history list in Clinical Details
Fixed an issue where the merge field Clinical Details History was not working for templates.

Clinical

ZED-9838

Office staff can now turn on and off SMS in a patient's clinical History
The option to hide SMS messages in the Clinical patient history will now work if the user does not have a
doctor code.

Clinical

ZED-9839

The batch writer is now prompting for letter status selection
Fixed missing prompt to set document status when editing a letter associated with a batch in Batch Letter
Writer.

Clinical

ZED-9841

Template custom merge fields no longer have a black background
Fixed the issue where custom merge fields have a black background on clinical templates.

Zedmed v37.5.0

Summary Views - Document Preview

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



When you click on a supported document in Summary Views, a preview opens beside it. This feature supports all items in the
Documents tab and documents in other tabs. It does not support images, provider file formats and MyHealth Record. For example,
you cannot preview a pathology referral, but you can preview a referral letter. Selecting an unsupported format will do nothing.

Use the Preview menu to zoom in and out, move to the next page and print. The zoom level will be retained for that session.

Document Preview is enabled by default. It can be disabled under My Options > Enable Document Preview.

Jones, Ms Marrianna-Louise

Address: © Jones Pl

GOWRIE 2904
DOB: 19/05/1967 Home:
Age: 57 years Work:
Medicare No: 22950398741 Mobile: 0405291730
File No: 17 Occupation:

Hosp UR No:
MHR Status: My Health Record available, Consent to Upload

08 0o0-EE

FULL SUMMARY
5 17 e 2.

G AT Lt s
sorem 8 Jonss
FORE TR0

B B - min

Vet Moot TTRIETS

mgas s Ko s Mg

} Summary Views
: Eamy sentan:
Problems (]
Referrals righ e
' £ Letters
Results 1 i 5 ]
: 15172024 Immunisations
i 15/10/2024 RTF K ferral - Dr Vivian Mortier :
Allergies E Referral Letters
© 15/10/2024 RTF Referral - Dr Vivian Mortier oo T . S g  Femere | TAKE 3748 B AR SRECTES
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Tyro ePayment Reconciliation report

This new report will help practices reconcile Tyro ePayments when doing banking. These payments use Zedmed's Payment Gateway
to collect payment information for Online Appointments (OLA). The banking reports include ePayments and still need to be run, but if

there is a discrepancy, this report will help with the reconciliation process.

The report is run for each bank list and will only show back lists configured for Payment Gateway.

To open the report, select Banking > Tyro ePayment Reconciliation.

Tyro ePayment Reconciliation
Use this sereen to reconcile ePayments between Zedmed and Tyro on previous and current batches and sessions,
Reconcile by
(@) Batch
Batch Number | <Current Batch> v
O session
Session Number |10 Started On 16/10/2024 11:12:53 AM vl
() Date Range
From [17/102024 3] |[-| To [17/10/2024 =1
Print Screen | Expaort
| 11

Banklist
D Show Inactive Bank Account
Phillip Davis v
The field above will only contain banklists that
have been comedtly configured to use the Tyro
Payment Gateway, This indudes having a Reporting
Password and Surcharge specified.

Please be aware that recent transactions will not be
displayed until the Tyro data is available, Data will
be available approximately 15 minutes after having

been processed.

The report pulls information from Zedmed and Tryo, which should reconcile to a $0.00 discrepancy.
In the example below, you can see an ePayment refund was processed in Zedmed and also in Tyro.
The Tyro transaction fee is not included, as it is not received by Zedmed and would prevent reconciliation.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



https://help.zedmed.com.au/help/set-up-payment-gateway#set-up-zedmed-bank-accounts
https://help.zedmed.com.au/help/payment-gateway-refund

Branch 1

Tyro ePayment Reconciliation Report

Page 1

Criteria

Bank Account
Recondle by: Date Range

Philip Davis

16/10/2024 - 17/10/2024

Date Patient Name
164102024 10:38:02 AN J&™bs, Happy
16/10/2024 10:38:02 AN Jones, Happy
1641002024 10:39-06 AM Abboft, Gabris!
1B/10/2024 11:03:48 AM

16/10/2024 11:15:23 AN Jones, Happy
Number of Transactions 5

Receipt ID Transaction 1D Zedmed (§) Tyro ($) Type Acquirer Merchant
3 5feB458-2402- 43bd-bbbd-eb c103bcbdd £71.30 £71.30 PAYMENT ABPROVED TESTZEDMED
3 -571.30 50.00
4 CAZZocli-coi7-Mes-ae2f-a84 {20980 S $105.30 $105.30 PAYMENT APPROVED TESTZEDMED
Happy Jones 50.00 -571.20 REFUND APPROVED TESTZEDMED
] 00529126-8477-4197-b137-SebSbde2aded $105.30 $105.30 PAYMENT AFPROVED TESTZEDMED
$210.60 $210.60 Discrepancy $0.00

Appointment grid enhancements

Optimised the Appointment grid to open faster.

Clinical |ZED-9537 . . .

Excessive Appointment Grid refreshes have been reduced for a faster start-up.

The Appointment grid's date now shows the name of the day and month.

The date picker on the appointment grid now displays the name of the day and month.

You can use text to change the date: "yesterday", "today", "today+4", "eom", "bom" and the day's name.
Clinical |ZED-9569

Waiting Room  Patient  Bill Encounters RefDrs Close Extra  Surgical Procedures

AlDocors

| HEDRICK, WARREN Appointment D.nebiRACE

b Wednesday 16 Oct
Branc ) E :

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



The Appointment grid now stays open a Patient's Details is opened.
Selecting Patient Details will now display the patient details without closing the Appointments grid. You can
also open the patient Acct Enquiry.

=
ents Diplay Grid =
nt Search View Refresh WaitingRoom Patient Bill Encounters RefDrs Close Extra  Surgical Procedures

-|<All Doctors> " #4 Jones, Happy x
ekl Acc oy At B Letws Oivicalifomation it Quots Recept WaktingRoom _ Appornimants Exbas
hTMI) 7‘ Personal 3 Practice
Family Name Jones ] File# 22 PullFile @
Further Details
e Given Name Happy initial  Hosp, UR No Clinical Warnings
Notepad Prefemed Name Former  Usual Branch Branch 1 2) -
[ eHeattn Title Mr SexatBith M - Firstin Lastin
Messages Pronouns. - Trpe | | status [cument
Date of Bitth 4/12/1964 ] Lo | —
B Home  ~ 1ElerstonAve * Jones, Happy (22) 2of
Family Links
Suburb ISABELLA PLAINS 2805 =y
Preferred Contact | granch Defautt inot set o] |
Jones, Happy Pl 5.00 ~
Maobils v
k bl Fund
Do Not Send SMS (] Default Appointment SMs (] e P
Email e e ———
Usual Dr | None ]| et
Medicare 2950 862041 2 Exp
Ada Details
eteran B
R fo Other Contacts
Stetitet NOK Name
Pen. Stat. % PBS Co-payment [ % Mobke -
ATt Not Recorded o || 2eeturicontext Nome
Ethnicity a % Moble -
set
Bl -
. Alerts
Clinical |ZED-9577 “amTenedte Gt Grd, O rd Guete ™
-
Delete print Patient Verification Find Close Cancel

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Change Search for Appointments to show Doctor's Full Name

The appointment search now displays the name of the doctor or resource. It previously only showed their
codes.

Search for Appointments

Patlent Jones, Happy S Find
.. From  16/09/2024 s To 17/10/2025 4| ma
Clinical |ZED-9578 + 0

-
Date Time Duration Doctor Resource  Eranch Status Notes

by 17100004 To- 1800 AME {800 Phillip Bayle 1 ________IMED TAdne 1 ]
Wed 16/10/2024 10:45:00 Ab 10 Dr Phitlip Dnm‘ MED  Attended

Goto ] [Print List Relete Refresh

Clgse

- Revise how dark mode is applied to the appointment screen toolbar
Clinical |ZED-9654 . . .
The appointments grid ow opens faster when using modern (dark) theme.

Fixes and enhancements

. Error occurs for deleting a Doctor Group from appointments
Office ZED-9517 . . . .
Fixed database error displayed when deleting an unused appointment doctor group.

Updated Zedmed's invoice wording to “Tax Invoice”

When an invoice is printed, Zedmed will now use the words “Tax Invoice” in the heading instead of “Account”
or “Duplicate Account”.

Office | ZED-9535 . DM‘ZEDMED DEMONSTRATION SYSTEM .
? Level 3, 60 Albert Road|
Provider : 2121331W SOUTH MELBOURNE 3205

Phone : 03 9284 3300

Printed On : 17/10/2024
Page : 1

Tax Invoice
Ms Marrianna-Louise Jones

6 Jones Pl
b

‘GOWRIE 2904

Patients' email addresses now have standalone fields in the Office.

The patient details form in Office now shows the phone number and email address in separate fields, instead
of combining them in a shared dropdown field.

Suburb GOWRIE 2904
Preferred Contact
Methog Dranch Default inot set)

e 1| 0406991730
Office | ZED-9540 =

Do Not Send SM5 [[] Default Appointment sMs I8
E"Re“ zedmedtesting+mljones @ gmail.com

Usual Dr  Davis, Phillip

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Office

ZED-9567

The Appointment Op List will no longer duplicate patients
Fixed issue where patient appointments are incorrectly duplicated on the Appointment Op List when their
appointment is for a different branch to the one logged in as.

Office

ZED-9581

Remove unavailable bank accounts from bank account list
A new checkbox, Exclude unavailable bank accounts, in the Practice Details > Bank Accounts tab hides
unavailable accounts from view.

Practice Details

Practice [ @ Exciude unavailable bank ui(ounu I
Branches Name '

Albert Road MC Bank Account ~
Bank Accounts

Departments Code BNK 8 currently Available
Integrations Bank Westpac

Claiming Configuration  Branch  South Melbourne 3205

Account ® 091919 1919191919

Address

Office

ZED-9646

Referrals Expiring Report no longer shows Cancelled Appointments
Cancelled appointments will not be included in the Expiring Referrals report.

Office &
Clinical

ZED-9628

Referral doctor email address field is now bigger
The size of the email address field for referral doctors has been increased from 40 to 255 characters.

Clinical

ZED-9519

The HealthLink referrals Print icon is no longer greyed out
An issue preventing users from reprinting manually created HealthLink referrals has been fixed.

Clinical

ZED-9536

The referring doctor is now used for reprints, not the doctor that's logged in.

When reprinting or resending a pathology or a radiology referral (right-click in Summary Views), Zedmed
Clinical will always use the original referring doctor's details (name and signature) instead of the currently
logged-in user.

Clinical

ZED-9562

Upgrade Zedmed to latest version of MSXML
Upgraded an internal component used in Zedmed Clinical to fix errors occurring at some clinics when
opening patient files.

Clinical

ZED-9565

Fixed an Invalid archive file error that occurred when resending a referral via secure send
The Referrals Ul in Zedmed Clinical will no longer show an error when attempting to resend a referral letter
in Today's Referrals using Secure Send.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



A patient's History View now includes SMS messages

A patient clinical History View now includes SMS communications, including replies, reminders, secure send
and direct messages. This is on by default.

The information can be hidden in Tools > My Options > Show SMS Messages in the History View checkbox.

History View

Oldest Encounter: 14/10/2024
. | Search Billing ¢ -
2/123|Viel 8 History| B\\ﬁam visible: Last 10 Consultations v & ndude MHR

15/10/2024 (Tue) 3:23pm with Dr Phillip Davis at MED, for 4m 41
Adergy: No Known Alergies (recorded 15 Oct 2024)

No Known Aliergies (recorded 15 Oct 2024)
Mo RFE
Clinical | ZED-9570 Rot: Rosuvastatin Smg Coated Tablet Smg [30] - Qty: 130 Rpts: 5 - TAKE 2 TAB BID
15/1002024 (Tue} 3:41pm with Dr Phillip Davis at MED, for 9m 22s
No RFE
151002024 (Tue} 2:30pm with Dr Phillip Davis at MED, for 6m 11s
No RFE

The referral RTF Take 2 has been renamed to RTF Take 2 renamed
Referrsl has been duplicated
Referral has been dupicated
14/110/2024 (Mon) 3:17pm SMS Message to 61408591730 (Sent)
i ith De Philic Dayis 2024 at 0330 3

41102024 (Mon) 3:05pm SM5 Message to 61406981730 (Sent)
SMS message sent from Update Results
Message Category: Result
4/10/2024 (Mon) 3:04pm SMS Message to 61406981730 {Sent)
Patient Service Report SMS
Wessage Category: Buk
411012024 (Mon) 3:01pm 5M5 Message to 61406991730 (Sent)
Wou have an appointment on 15/10/2024 at 5:30 T.‘ with Dr Philip Davis at Branch 1. Please ring 03 5284 3300 if you cannot attend |
Message Category: Reminder

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



You can now hide and unhide all public (global) templates
Public Templates can now be hidden from the Ul in Clinical using the Hide Clinical Templates utility.
This utility does not currently work in the Cloud.

This only applies to global templates, so the template will be hidden for all users.
This will help with templates whose owner is no longer with the practice.
Individual user's templates can be removed by that user if they don't want to see them.

To open the utility:

1. From Clinical, select Utilities > Hide Clinical Templates.
2. Dragthe template to the Hidden Templates pane.
3. Select Apply These Settings.

¥4 Zedmed Template Maintenance = [m] x

The purpose of this utility is to hide Internal Clinical Templates
you no longer need or want accessible by the system.

Vighle Tempiste; 3 Hidden Templatas

Template Name Slole Templatehlame Slate
[Erveiope DL Global Template

Full Higtoy Global Template Quick Doc
[Fudl Suenenary HSW - Workcover

Fudl Suenenary - Female VIC - TAC Centiicate

IGP Mental Health Plan 2710 WA - \WorkCoves First

GP Mental Health Plan 2710 (Custom Menge Fiald) WA - WorkCoves Progress
IGP Mental Health Raview 2712 WA - Waikcover Final

G Masnal Haalth Ravisw 2712 (Cuttorn Marga Fiald)

GPMP 721

GPWP 721 [Custom Mege Field)
GPWP 721 Asthma
GPMP 721 Asthma (Custom Mesge Fieid)
e - GPMP 721 Coronary Heart Disease
Clinical ZED-9596 GPMP 721 Coranaty Heart Disease (Cuttom Merge Field)
GPWP 721 Deprossion Ankiety Disorder
GPHP 721 Deprossion Ansiely Disorder [Custom Merge Fi. .
GPMP 721 Disbetes
GPMP 721 Diabates [Custom Meaige Feld]
GPMP 721 Distaosthitiz
GPHP 721 Dstacarthiitis (Cusstom Mevge Fiald) h
GPMP Review 725(Custom Merge Field)
GPMP Review 725
[Global template - Favourile Quick Doc
HMR Rederral S00
Health Azsessment 700706
Health Asgessment 700706 [Custom Merge Fiald)
Health Chack ltem T18 o 719

Usage: Drag and Diop ltems from one side o the olher. Apply These Settngs Usage: Drag and Ciop ltems from one side to the other,

(Connected) Edl |

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Approval AuthoMake phone approval hotline details text that can be copied

The Medicare Number, Pension/DVA Number, Authority Number and Prescriber Number on the Script
Authority Form now have a copy button and are also selectable text. This makes it easier to transfer the
information into HPOS when requesting authority scripts.

Phene Approval Hotline 1800 888333 RPES Hotline 1800 552 580
Jones, Happy
1 EMerston Ave ISABELLA PLAINS 2905
Medicare Number: 29508620412 Copy
Pension/DVA Number:
Autharity Humber: 02000024 I Copy
Prescriber Humber: SBTTTTI Copy
Rivastigmine 1.5mg Oral Capsule 1.5mg [56]
TAKE 1 CAP
Quantity: 1*56 Repeats: 5
Streamlined Approval Humber: Last:
P Authority:
Clinical |ZED-9600
Text to Appear on Prescription Authority Restriction
Mild to moderately severe Alzhelmer diseaseTrestment Mild to maderately severe Alzheimer disease
Phase: Initial Clinical critema: Treatment Phase: Initial
Fatient must have a baseline Mini-Mental State Clinkcal criteria: _
Examination [MMSE) or Standardised Mini-Mental State Patient must have a baseline Mini-Mental State
Examination (SMMSE} score af 10 or mare, AND Examination [MMSE| or Standardised Mini-Mental State |
The condition must be confirmed by, or in consultation Examination [SMMSE} score of 10 or mare,
with, a specialist/consultant physician fincluding a AND
psychiatrist), AND The condition must be canfirmed by, or in consultation
The treatment must be the sole PBS-subsidized therapy with, a specialist/consultant physidan fincluding a
Far this condition. The authority application must include psyehiatrist],
the resull of the baseling MMSE o SMMSE, If this score is AND |
The trastment mick he the cale PR cohsidicad Hharane el
c #s/Mokes about Rivastigmine 1.5myg Oral Capsule 1.5 mg|56]
-
v
[C] Send Directly ba Patient? [ Previous Authority?
Postal Autharity Diefer Private Cancel
CTRL + Z no longer Closes a Patient file
Clinical | ZED-9627 | Pressing Ctrl-Zin Clinical will no longer close the active patient tab. This happened by accident when users

selected Ctrl-Z to undo (Windows function).

Zedmed v37.4.2

Fix

Clinical

ZED-9785

Fixed the slow Waiting Room opening time
Doctors were experiencing a slow loading time when opening the Waiting Room in Clinical.

Zedmed v37.4.0

Fixes and enhancements

Office

ZED-9754

Delay in Claim Payments Screen and selecting an invoice from the Payments Tab.
Fixed performance issues when opening the claim payment view and when opening claims by individual ID
(e.g. by double-clicking a payment).

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Office

ZED-9756

Changing disable invoice adjustments number of days to a practice setting

Users can now specify the number of days during which invoice adjustments cannot be made after submitting
a claim. The setting can be accessed from Practice Details [tab] > Disable invoice adjustment for days. The
default setting will be 1 day.

Office

ZED-9751

Add link to Patient details from claims screen
Added aright-click menu to the Claim Status view to enable opening patient demographics for a claim.

Office

ZED-9747

Office attendance query slow
Fixed possible performance issue with the Office waiting room.

Clinical

ZED-9739

Letter Formatting issue when viewing letter
Fixed the layout of documents viewed from the Summary Views Documents Tab in the Patient Record,
margins are now displayed correctly

Clinical

ZED-9740

Cannot print document on result inbox
Fixed an issue with printing pdf results from the results inbox.

Clinical

ZED-9709

RTF Letters under Zedmed\Letters Folder on Client Machines

Removed Clinical letter writer “autosave” function that did nothing but save rtf documents into the Zedmed
folder. System will no longer prompt a user to save a letter in Clinical if it has no changes to it since the last
save.

Zedmed v37.2.3

Shortcuts to specific sections:

Payment Gateway enhancements

Branch Selector for billing

Date stamp for Patient Details notes
Summary Views - Document Preview
Tyro ePayment Reconciliation report
Document versioning

Suppressed invoices workflow
Improved claim management

Secure Send enhancements
Improved WP Tools

General enhancements

Resolved issues

Document versioning

Instead of editing Documents and Referral Letters, you now Create new versions. This ensures that a document's history of changes is

retained. This applies to the following document types: Letters, Referrals, CDA Referrals and Batch Letter Writer letters distributed
using print or send.

To update a document, right-click it and select Create New Version. A new version will be created and opened for editing.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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E Letters
=1 30/07/2024 Quene Te .~ ™
30/07/2024 Queue Tt View Document...
30/07/2024 Centrelinl | C4
26/07/2024 Versionink 3 Delete Document...

Newly created Documents and Referral letters will have a v1 suffix, and subsequent versions will increase to v2, v3 etc. Versioned
documents are displayed using a tree structure. A new document version can be created from any version of a document, it does not

have to be the latest.

Summary Views

Problems L
= Forms
26/07/2024 Health Assessment 700-706 v2
Referrals 1
B Letters
[ 30/07/2024 Queue Testing v2
Results 30/07/2024 Centrelink Medical Certificate v1
26/07/2024 Versioning testing v1
s 26/07/2024 BLW versioning test v2

&

26/07/2024 Medical Certificate v2
24/07/2024 Ref Letter - Smoking v1
Allergies = Referral Letters

@ ) 29/07/2024 eReferral | Dr Vivian Mortier v1
Rissre/ECE (@ () 26/07/2024 eReferral | Dr Vivian Mortier w1
# @ @ 260772024 eReferral | Dr Vivian Mortier v3

® (@ 26/07/2024 Testing Veersioning renamed - Dr Vivian Mortier v3

Deaupents © 23/07/2024 testing - Fred Tester2 v
B My Health Record Summaries
Attachments () 30/07/2024 Shared Health Summary
) 28/07/2024 Event Summary v1
Msasiwsnante = B 26/07/2024 Event Summary v3
@ 26/07/2024 Shared Health Summary
: HealthLink
Medications

Versioning is turned off by default and is enabled in Global Options. You can also restrict the ability to delete or edit a document over
a certain age. By default, it is set to O in Clinical >Global Options for no time limits.

To learn more, see document versioning.

Suppressed invoices workflow

Bulk Bill and DVA can be disabled for Medicare/DVA invoices so that the claims can be reviewed in the Claims tab and then
submitted. This provides more oversight and prevents claims from being submitted for invoices that must be voided.

See ZED-9289 for how to enable this option.

New Invoice
Invoice
Patient Mr Knut Holloway DVA V55123343 HCCE Safety Pens. Status Full DVA
File 41 DOB 19/05/1952 (72)
- - Payer Debts g
Payer | Medicare ~ || Add/Edit Payer | Patient y Credit
e |t ] Tt 365.60 3330.95
Applicable Fee Type MC
. EEeT Deferred 0.00
Doctor D, Phillip ~|la
. S Fund Details
ety To Starts Mths  Motes Fund 5 Fund Fee ljpe
Referral Dr Adelaide Path Partners FD 08/11/2023 12 ~
Refund/Gap Calculation Invaice Style
Claim Fund Medicare Print Gap Corporate |:|
Services
Date Item# Description  GST selectable item Fee Tax Unit Value Gty Amount Notes Estim. Refund Gap
S| [ [wve e | oo 1] om| [ oo oo
30/08/2024 23 professional attendance by a genera MC FRE 41.20 1 41.20 0 0
Assist Fee | Properties Add Change Delete Total 41.20 Disc. 0.00 Gap 0.00
Doctor Assigned Billing Codes Message
Add Al This is the invoice message
= s Medicare is the payer but | send Medicare Bulk Billing Consent |
Billing Instructions = L !
cannot be selected.
Defer Family | | Ecupse | [maontine| | sukBil | [comboinv. [ Print || Emai QuickPay | | cancel Help

The Claims tab has enhancements to help manage claims for suppressed invoices.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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¥4 Claim Status [m] X
. ———
Refresh Default View Goch gllance L Sl Basgad s Check Claim Status Transmit Claims
Claims  Payments View all Claims for Suppressed invoices
From [E07/2024 @~ | @ |AllSubmitted Claim Types Branch | <ALLs ~|  Dodor [<all> ~| caimD Manu'f‘”y rerrel-"!" the status of a
Claim or Claim Payment
To 1/08/202¢ (@~ |I (O Mot Submitted / Suppressed I Status | <ALL> | Patient AN Find Patient
[] inw/Service/Assessor  Date Inw/Service  Status Account Payer Patient Qutstanding Paid Doctor Claim 1D Medicare Ref.
B Inv35418 25/07/2024 COMPLETE | Medicare simkins, Talia 33885 $42.85 Igor Fuller 214404 DE616E ~
23 25/07/2024 Overpaid 53885 542,85
B | Ine 35419 25/07/2024 COMPLETE | Department of Veterans ... | Chapman, William 512345 $140.50 Igor Fuller 214405 BI855@
44 25/07/2024 COwverpaid §12345 $140.50
B[] inw 35420 25/07/2024 REJECTED..| Post, Jamee Post, lamee §12055 $0.00  Augustus Eason 214402
104 25/07/2024 Unpaid $12055 $0.00
Medicare Patient is eligible to claim for Medicare with details provided.
Fund Check Fund and Membership Card details
B[ Ine 35422 25/07/2024 WITHME... | Medicare Simkins, Talia 103,50 $0.00  Igor Fuller 214406 DEEITE
- 25/07/2024 Unpaid $103.50 $0.00
B Inw 35423 25/07/2024 WITHME...| Department of Veterans .. | Chapman, William 340,95 50,00 Igor Fuller 214407 B9856@
2 25/07/2024 Unpaid 54095 $0.00
=] Inw 35425 29/07/2024 COMPLETE | Medicare Aldridge, Joseph 51895 $19.60 Igor Fuller 214410 DesdTR
91890 29/07/2024 Querpaid 31895 $19.60
B Inw 35426 30/07/2024 COMPLETE | Medicare Alstan, Mia 57130 54285 Igar Fuller 214412 SAPOODO030072408230712
23 30/07/2024 Underpaid $71.30 $42.85
New Account Payer column
v
< >
Print Report | Show Report Close

To learn more, see the Suppressed claims workflow.

Improved claim management

Easy Account Enquiry Access

When you double-click on an invoice in the Claims tab, it will open the patient's Account Enquiry screen with that invoice highlighted.

Closing the invoice will take you back to the Claims tab. This makes it easier to review claims.

More robust claims.

e To avoid claims failing due to invoice changes, adjustments cannot be made to invoices with claims submitted in the previous 7 days.
If the invoice is incorrect, select it in the Claims tab and click Voice Rejected Invoices to remove it.
o When receipting, a warning will suggest waiting 24 hours if full payment information has not been received from Medicare.
e The Claims tab has a Check Claim Status button so staff can manually refresh the status of a claim or claim payment.

To learn more, see the Review Claims guide > Claim Management enhancements

Specific updates for invoices and claims

Branches ¥ e
. v MEXDDOOT Values
Office | ZED-9289 || ssnkccaunts =R weacmins anorio (e | EE :
Departments eHealth Information 3 Values
Integrations HPI-O |8003 6282 3336 7349 Search Hl Semvice | a|rectH| Epuyisicy 3 Values
Claiming Configuration
Organisation ~ Organisation u :l Lo

Add "Force Claim Suppression" to suppress submitting Medicare/DVA claims
A new option under Practice Details called Force Claim Suppression. Ticking this box will disable the ability
to submit a DVA or bulk bill claims directly from the invoice screen. Note that this setting is off by default.

Practice Details

Practice Name

| Category Fields

General Practice

General practice medica|w |
———— semvice = e

T s [ | s

Tyro ~

Integrated Eftpos/Easyclaim provider
g Etin = = Text Fields
4 Force Claim Supression Name
Checking this box will disable the Bulk BilyDVA button on the invoicing screen, 6
1
APl Gateway ey | | Iz J

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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Office |ZED-9290

Changes to Claims Status Screen
Added Account Payer to the claim status view.

Changed the option Not Submitted to Not Submitted / Suppressed. You can choose this option, then select
Refresh to display only the Suppressed invoices queued in the Claims tab.

Office | ZED-9291

Restrict changes to invoices for submitted claims

Disabled the Account Enquiry screen's Adjustment button for all claims less than 7 days old. This applies to
Bulk Bill, DVA and Eclipse claims. MA Online and Tyro Easy Claim will still have the button available.

P4 Account Enquiry

Patient  Simkins, Talia

Payer Medicare ~ Recalculate

Curt 178.65 30+ 0.00 60+ 0.00 90+ 0.00
Transaction

Invoices Date Patient HIC LM B Dr Value  Outstanding Bulk Billing Consent

I ssqsqlnifbs'fz'diilsiums, TALIA 66828 MED IF 36.30 36.30
o | 35422 SIMKINS, TALIA €617@ MED IF 103.50 103.50
el 35418 25/07/2024 SIMKINS, TALIA 66168 MED IF 36.30 3e.85

Adjustment ] Renvoice | Reassign  Payments Receipt | MAOrine | BulkBill | EasyCiaim | ECUPSE View Claim || Send BB Consent | View BB Consent

Office | ZED-9360

Added a 'Check Claim Status' button

Added a Check Claim Status button to the Claims Tab so staff can manually refresh the status of a Claim or
Claim Payment.

Office |ZED-9361

Change the auto-void criteria for receipting off payments

Added additional checks to prevent the automated receipting of claims that have been paid but where the
processing report is incomplete.

Office |ZED-9367

Fast access to a claim's invoice from the Claims tab

Changed the double-click function in the Claim tab. Double-clicking a claim will now take you to the
associated invoice in the patient's Account Enquiry screen.

Secure Send enhancements

Features summary:

e Cannow be used for patients without an account payer.
e Sender can override the security code requirements
e More meaningful file names

e Can now Secure Send from Summary Views > Images | Attachments | Results
e Can now Secure Send from the Results Inbox.

To learn more, see the Secure Send guide.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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Secure Send now provides more descriptive file names.
The filename is now formatted as <Patient Given Name><Patient Family Name><File Name>.

Sign Out
. My Files Received
Office | ZED-9323
. Lawrence_Church_DSAppts. 01/08/2024 &
Ccsv
. Lawrence_Church_BMP 01/08/2024 L
Scan.BMP
Secure Send can now be used for patients without an account payer.
Office |ZED-9325 . . . .
: e The patient will be the Payer in the Secure Send dialogue
e The patient's email and mobile will prepopulate the Secure Send dialogue fields.
Secure send can be used from more Summary Views tabs
e Summary Views > Images (can send image files)
e Summary Views > Attachments (with file type restrictions)
e Summary Views > Results (right-click View Results > Send to Patient)
For security, some files (exe, dll etc) cannot be sent as shown in the restricted list below
Right-click and select Send to Patient.
Summary Views
Problems 0
El General
[ 01/08/2024 01:45pm BMP Scan Created By :PDAVIS
el [7] 01/08/2024 01:45pm JPG Scan Created By :PDAVIS
[] 01/08/2024 01:45pm PDF Scan Created By :PDAVIS
Results [] 01/08/2024 01:45pm TIFF Scan Created By :PDAVIS
ZED-9326 Encounter Linked
. i Result Linked
Office | ZED-9327 (ETIOINEEaROn
ZED-9369 Allergies
Images/ECG
Summary Views
Problems i
01/08/2024 DSAnnte revelrmad
01/08/2024 Co| O View...
Referrals
Rename...
Results Export...
Immunisations X Delete...
Attachments

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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Removed some restrictions on the file types supported by Secure Send
Restrictions have been updated to allow more file types to be sent using Secure Send.
The following file types are still restricted due to the security risks they pose (malware etc):

Office | ZED-9333 bat|exe|cmd|sh|php([@-9]1)|pl|cgi|386|d11|com|torrent|js|app|jar|pif|vb]|

vbscript|wsf|asp|cer|csr|jsp|drv|sys| ade|adp|bas|chm|cpl|ert|csh|fxp|
hlp|hta|inf|ins|isp|jse|htaccess|htpasswd|ksh|1lnk|mdb|mde|mdt|mdw|msc|
msi|msp| mst|ops|pcd|prg|reg|scr|sct|shb|shs|url|vbe|vbs|wsc|wst|ush

Secure Send can be used without the security code requirement
The sender can use a checkbox to override the one-time security code requirement. This is the code sent to
the patient to open the portal and access files sent to the patient.

Files that required a security code when they were sent, are not displayed if the portal is opened without a
security code requirement.

Send BMP Scan X

This will send a download link for the selected file to Patient/Payer via Email and/or SM5. The
download will prompt for a one-time password on the respective email/mobile no.

Patient Church, Mr Lawrence

Payer Ehurd{,‘Mr Lawrence -]

Notifications to be sent

Office | ZED-9366

[ Recipient Email zedmedtesting=LChurch @gmail.com |

[ Recipient Mobile [0491 574 632 |

[ Fin not required (Less secure) ]
Send a copy to
Copy To Email Copy Ta Mabile

ﬁn Send | | Cancel

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help



Use Secure Send from the Results Inbox

Secure Send now allows you to send patient results from the Results Inbox.
1) Select the result

2) Select Send to Patient.

Summary Views > Results are also supported by Secure Send.

P4 Results Inbox
Results
Showing Records:(1 - 18 / 18) - Sorted By Patient Full Name [Ascending]

2l «r |0 P E| % G‘;‘IF.“'F‘;H*:':‘ Role User Roles v | Result/Page 50
Type All w | User Davis, Dr Phillip [PDAVIS) w
Patient Assigned To Result Reported Date  Result Collected Date ™ Result Type  Result Description
Office ZED-9369 ) Andrews, lohn Doctor 0znzms 0211/2018 Result Colorectal Cancer Stru
) Hunter, steven Doctor on2me 02n120e Result Colorectal Cancer Stru
o Hunter, Steven Davis, Dr Phillip (PDA.. 16/07/2020 15/07/2020 Result TESTING RESULT ONE
) Jones, Ms Marrianna: Doctor 21172023 ‘220 Result. Cycle® 5.+ End of gycle
() Jones, Ms Marrianna- Doctor 2211172023 221172023 Result Cycle® 1 - End of cycle
o Jones, Ms Manianna- Doctor 222023 2212023 Besult Cycle® 2 - End of cycle
o Jones, Ms Marrianna- Doctor 2172023 22172023 Result Cyele= 3 - End of ayele
o MCINTYRE, Goldie  Davis, Dr Phillip (PDA... 16710/2021 1511072021 Result TESTING RESULT FOUL
o Xpatriot, Mr English Doctor 02111/2018 02/11/2018 Result Colorectal Cancer Stru

<

Result Navigation
B Eullscreen | 4 Brior

“‘ Routine Urgent Al OK, Motify | Mark Result Send to Patient
He Appointmént  Appointment Fatient Complete Patient Notified

To learn more, see the Results Inbox guide.

Updated where Secure Send lab reports display the phone number
Office |ZED-9468 |The default Pathology and Radiology reports used for Secure Send now display the phone number in the
branch name and address section.

Improved WP Tools

Zedmed v37 includes new features for creating and editing Clinical templates.

Table resizing

Add a table within another table.

e Resize atable by dragging on a border; left, right, top or bottom.
e Resize columns and rows.

e Resize atable inside another table.

Hyperlinks

Hyperlinks can now be added using the Toolbar button and Edit menu by typing a URL in the document. E.g
HTTPS://HyperlinkURLhere.com.au

Word wrapping around images

e Handle pictures as a character; the picture is inserted in the middle of a sentence

e Relation to paragraph - auto wrap left or right; paragraph text is wrapped to the left or the right of the picture
e Relation to paragraph - wrap left and right; paragraph text is wrapped on the left and the right of the picture
e Relation to page - no wrapping; the picture is displayed over the text

e Relation to page - wrap left and right; text on the page is wrapped on the left and the right of the picture

Colour picker

Provides a greater range of colours, the ability to create and save custom shades and a paragraph background colour button.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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General enhancements

New Appointment Counts Report
A new report option, “Appointment Counts”, has been added to the Appointments Report.

Appointment Report
Style Criteria
() Appaintments Only Order by Name Date from To
() Appointments and Available Slots ‘23}08;"2024 :| E |2WW2024 = | El
(®) Appointment Counts Time from To
() Cancelled/Missed ‘06:00 :| |22:DO :|
Cancelled Only
Missed Only
O Send Appointments via SMS Modify SMS Text Branch
Test Branch 1 it
Report Doctar
Al |
Display Options
Resource
A { 3 1
iddresses Include History Al v
Referral Details . .
Appointment Type
Separator Lines 1
All v|
Preferred Name
Office ZED-9079 Print Screen Export

It shows the number of appointments per practitioner with the total number of appointments for the
selected time range. You can apply filters such as appointment type and select specific practitioners. This
report does not capture cancelled, unavailable and non-patient appointments.

Test Branch 1

Page 1
Appointment Counts

Monday 26 Aug 2024 From 06:00 To 22:00 10 Appointment(s)
Treating Doctor/Resource Number of Appointments

Dr Grenville Howell 3

Mr Phillip Davis 5

Dr WARREM HEDRICK 2

Total Appointments 10

To learn more, see the Appointment Report guide.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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Preferred Name and pronouns displayed in Appointment Details
Added an option to display preferred name and/or pronouns in the appointment grid.

Select View > Options to open the Appointment Display options to enable the pronoun options.

¥4 Appointments Display Grid - Auto-refresh every 1 minutes
Appointment  Search  View Refresh  Waiting Room  Patient  Bill  Encounters RefDrs  Close  Extra  Surgical Precedures

Legend cn|
9 ranch 1 ~|<All Doctors> ‘ Monday 26/08/2024 - r—'_
Options _ L = Day
Howell, Grenville | Hatcher,Danni | HEDRICK,WARREN
1 Column
2 Columns Appointments Display Options for Test Branch 1
s A Number of columns to display
4 Columns Doctors
o | [] Show minutes [ show am/pm
e i T T —
gA 0 & Columns [7] Show icons for attended, file pulled and billed
15 7 Celumns how EHealth icon
30/ 60 Ber Setup » oy | how ePayment icon
rS H [#] show SMS Response icon
Print el how Online Appointment icon
" 0] 48 Banks, Jayne  stanudig Lunss.‘q B
1 0 Show current time indicator
i emember last location of appointment screen
30 isplay multiple bookings on separate lines
. 45 i how patient file numbers
Office ZED-9233 = H how dinicview when opened
AM
1 [#] Use Next Available Appaintment Function
15| 46 Clapp, Jeremiah  Standard Cof
APPT. Search period: | 120| days from today
- 2]
5 Auto-refresh frequency [Minutes): 1
|| [] show Preferred Name instead of Given Name
0
1z | ] Show ronauns er e
15|
= Close Cancel

Added display of preferred name and pronouns to appointment details and the office and clinical waiting room

Appointment Details
Date: Thursday, 1 August 2024 Created by PD
Doctor Phillip Davis. on 01/08/24 at 13:52

e Jones, Happy (Jonsey) (They Them))
StartTme [10:00 | Clinic | Branch 1 i

Duration  |00:10 Status | Current el e e pon AL
Fistin  24/07/2024 Lastin  1/UB/2024 Type

“| Contact Details

Notes || | Phone (H) Wark (W)

-
=
EndTme [10:10  [§] Type [Std Conmitaton

Mobie 0491 570 157

To learn more, see the Appointment display options guide.

Preferred Name and pronouns displayed in Attendance Details
Office ZED-9321 | The Attendance Details screen now shows the patient's preferred name and pronouns as shown in the
screenshot above.

For the most up-to-date documentation version, visit https://help.zedmed.com.au/help
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A batch search for a patient's IHI number can exclude Archived and Deceased patients
Practice setup > Practice tab > HI Service Settings > Branch Settings tab.

The IHI Batch Update and Verification services can now be configured in Office to exclude specific Patients
according to their status (Archived, Deceased etc).

r Category Field:
Name [ZEDMED DEMONSTRATION SYSTEM | a:g”'y L
Branches N =
1 Values

A — ABN v | Meddaims Minor 1D [MPK000OT | | Expert to M]
Departmel o

EPAMMEl o) M Service Settings - %
Integratio|

- t h for IHI
Claiming { Bateh Settings | Bstch Search for
Service Settings [71Pertorm a regular Batch Search for a matching IHI for all patient records with no IHI recorded | Exclude Statuses

Frequenty Starting at Number of Records ; é;‘;‘::f"
Manthly ~ | | vmezon @ | joeoo ;:_-_| 100 [ cument
~ ¥ Deceased
Email exception reportis) to Send intramail to
[T AUGUSTUS |
& CHAMINDA
| CONMIE
Ll cpv
: DANNI
Office |ZED-9237 |
Batch Verification of IHIs
[#] Perform regular batch verification of IHis in patient records
Frequency Starting at Number of Records Exclude Statuses
Monthly v [1ozon B~ fose 5] [0 | [ Archived
Casual
- L Current
Verity records last updated more than 1 Months ~| ago. " Deceased
Email exception reportis) to Send intramail to
[ AUGUSTUS |
| CHAMINDA
| CONMIE
[ eev
] DaNN ~|
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You can now Un-pull afile

The Un-Pull File option has been added back to the Appointment Screen. You can no right-click Pull File or
Un-Pull File, and the status will be reflected in the Appointment Detaild and the folder icon.

Un-Pull File will remove the Pull File icon.

Standard Consult (10:15

Select Appointments X

45

7 Appointments for PD
On 29/08/2024

15| | Between 10:15 and 10:30

30 AL j 5 nsult (10:15 - 10:25)

45

(1]

15

. 30
Office |ZED-9265

45 T T 5 T - 1
Un-Pull File Attend Add Cancel Appointment Delete

(1]

s Cut Copy Paste Bill Patient Details

30 | Edit Appointment

a5 Add (Mon-Patient)
o Add (From Cancellation Waiting List) Chrl+W 3l
15 Details !
Edit
30|
Delete il
45
7 Un-Pull F Shift+F7 il

To learn more, see the Book an Appointment guide.

SMS appointment reminders can now include the day of the week.
A new merge field for the Day of the Week has been added to all Appointment, Recall reminder and Expired
Referral templates.

This has been added to the Zedmed default reminder message and Appointment reminders sent from the
Appointment Report. The Day will need to be added to custom messages.

¥4 5MS5 Configuration x
| Branch: |B|an(h 1 vl
Appointment Schedule
Appaintment Type
Appaointment Confirmation —|mTY_ SMS Reminder Message Insert Merge Field W
Recall Reminders fou have an appointmant onh Appt Day> lAum Date/Time> with <Dr Name> at Appointment Date and Time (12hr)
ring =Clinic Phone> if you cal 3
Recall Schedule Appaintment Date and Time (24hr)
Message Delay Appointment Day
Office |ZED-9304 Lt

Clinic Name
Clinic Phone

1 message, 10 characters remaining
Messages longer than 160 characters may incurr aditional charges fram your SMS provider ftypically once
per additional message}.

Mote that this size will include the full value of any merge fields {the count above is an estimate based on
the maximum value for each merge field)

Reset To Zedmed Message  Add Message  Delele Message

To learn more, see the Customise SMS text guide.
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You can now SMS a doctor when an appointment is booked

An SMS confirmation can be sent to a practitioner every time a patient makes an appointment with them.
The message will contain the patient's name and the appointment's date and time, and incur a cost for the
SMS.

Requirements:

e The doctor's mobile number must be added to the Doctor Details.

e The patient must receive a confirmation for the practitioner to receive a notification.

This means the Send Confirmation SMS must be manually ticked in the Appointment Details screen when
the appointment is booked- unless it is an OLA booking (as it is ticked by default).

Doctor Details
Identity Practice
= HIC Registered
Davis
Family Name |[EES | Ditade HIC Online
. Given Names |Phi|lip | Default ltem # l:l DVA Registered
Office | ZED-9412 REI Registered
Title IEl Search HI Service Fee type override o _Cl_ear_
EHealthID (HPI-I) |3003 5199 0002 6305 | DrType \DrTva
ABN/Bus. Name | | Branches
Branch | Test Branch 1 =
AHPRA Number |[MEDDO00000000 |
Bank List | Albert Road MC Bank Account ~|
Home Address = 5
| MA Format | General Practitioner i
[ | Pravider # [2408261F Otherprovigers | |
Suburb | | Claiming Claiming Service Unavailable Delete
I:' Erx Entity ID |8P5KG \Invoice Header| Invoice Footer| | Another
Phone Numbers PTOVidEFTyD€| v| [ Available Online
Home Phone | | Booking time buffer (in minutes) l:l
Home FE‘ | | Employment
[Mobne Phone (0422555555 SMS Appt. cOnf"matmn] No Employment Record!

To learn more, see the SMS Send options guide.

You can now Bill from the Appointment Grid
Right-click a patient's appointment and select Bill to open a New Invoice. This will pick up a practitioner's
billing information - just like billing from the Waiting Room.

104 ’
% Add (Non-Patient)
Office ZED‘9472 5 Add (From Cancellation Waiting List) Ctrl+W
1A L Details
5 Edit
20 Delete
45|
Pull File Shift+F7
12M™ A Attend 7
5 Cancel
=0 Patient Details
-5 Clinical Details
17 g i
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Vape has been added to the Smoking status options
Practitioners can now select Vape as a smoking method in the Patient's Clinical Record >Smoking tab.

If Vape is selected, it will show as a cigarette icon.

Holloway, Mr Knut

Address: 5 Jacob P,
BUGLE RANGES 5251

Current Encounter - Duration: 00:12:59

X B U S

Problems Drugs Observations Referrals

Patient Details MOK and Emergency Contact Family, Social & Past History

.,

-
Patient Uses lllicit Drugs

Clinical |ZED-9231 Patient - Holloway, Mr Knut %
Patient Details NOK and Emergency Contact Family, Social & Past History  Smoking  Alcohol  lllicit Drugs  Other Clitl * "
Current Smoking Status Smokes or Previously Smoked
OUnknown ONun Smoker OExSmoker @Smoker OC\gareﬂesO Cigars OPipe
Year Started l:l ¥ea d l:l
To learn more, see Navigating Clinical Records
An 'lllicit drugs' tab has been added to the patient's Clinical record.
Clinical now gives practitioners the ability to indicate if a patient is an illicit drug user and record related
details in the patient details maintenance screen. Tick the box to add the injection icon.
Helloway, Mr Knut iCurrent Encounter - Duration: 00:14:45
[ o ] o 0 go Qj’ @
Address: 5 Jacob Pl, Problems Drugs Obs s Referrals
BUGLE RANGES 5251
Clinical ZED-9232 Patient - Holloway, Mr Knut x

Smoking  Alcohol | Micit Drugs Jother ciil + ] *

Record information about the drugs|

To learn more, see Navigating Clinical Records
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Clinical

ZED-9263

Quick Documents Search - Template Selection screen
We have created a new Quick Document Search page called Template Selections. This displays all templates
inascrollable screen that will filter as you type a template's name.

Holloway, Mr Knut

Address: 5 Jacob Pl
BUGLE RANGES 5251
DOB: 19/05/1952
Age: 72 years
Medicare No: 53502861421
File No: 41
Hosp UR No:
MHR Status: Consent to Upload
Referrer: Adelaide Path Partners (Ph: 08 8238 9500)

Home:
Work:
Mobile:
Occupation:

Ay

o

Current Encounter - Duration: 00:00:48

X e U &

Pro s Observations R

G) Undefined Problem

errals  Immunis

Open Quick Documents Search using the new icon next to Quick Documents. Select the required tab and
start typing the template name to filter the list.

oA BB

s Diagrams Templates

| Use Code:

G) RFE [

o @ @ i e [

74 Template Selection

File

Start typing document name to
filter documents shown

e Y

X |

Favourites User Defined Letter Quick Docs  Summary

[ Full History

Full Summary

GCHHS-COVID-Virtual-Ward-ZM-18, 1, 22.rtf

GP Mental Health Plan 2710

GP Mental Health Plan 2710 (Custom Merge Field)

GP Mental Health Review 2712

GP Mental Health Review 2712 (Custom Merge Field)
GPMP 721

GPMP 721 {Custom Merge Field)

GPMP 721 Asthma (Custom Merge Field)

GPMP 721 Coronary Heart Disease (Custom Merge Field)
GRMP 721 Depression Anxisty Disorder (Custom Merge Fisld)
GPMP 721 Osteoarthritis {Custom Merge Field)

GPMP Review 725
Health Assessment 700-705

Health Check Item 718 or 719

HMR Referral 500

Hospital In-patient Admission

Immunisation Medical Exemption Form IMO11

Immunisations

InfraPsych

Investigations
tem 712 Comorehensive Medical Assessment

-3
H

aMiscellansous Practice Lettetead

OSTEOARTHRITIS
MBS ltem No. 721

GP MANAGEMENT PLAN

PN DATO 3PN ¢S Full Namd:
A wPater Dem ogra polcs Full AGIRSS:

s

e

[eastcare anns»

‘ «Omer N se

PAST MEDIGAL H 7 ORY.

Fop—r—
& eClinEal Detal Problem LSt (Curent) Wth Commeatses
Fatanea Pramame:

« xClnEal Det2I5 Frodem LISt (Res)veq) Wi CORentSes

[y mwony

[ oines cem e ran y e

\ v

o 0K

X cancel |

New Letter X

Letter Details

To: | Q

Cc

Opens Template
Selection screen

Subject:

Template: |

i |

Additional Details
Referral Date: 7 Exam. Date: =

Performed By: | Mr Phillip Davis

o oK

X Cancel

To learn more, see the Quick Documents guide.

The Template Selection screen will also open if you start a New Letter and search for a template.

Clinical

ZED-9322

Changes to Clinical Waiting Room column widths are now saved
The column width and order of the clinical waiting room is now be remembered for Zedmed user.
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Clinical Observations now has a paediatric WHO chart
In Clinical Observations > Physical > Measurements.

When you select a graph, the Graph type drop-down has a new option: WHO 0-2 Years, which displays the

Length, Weight and Head circumference chart for children 0-2 years old.

#4 Historical Graph m] ®
Length Chart (WHO) - Male Infant
Patient: Andrews, John - DOB: 211082016
94
2 BT o
20 16%
l— — 5%
o — B5%
%% — 0T%
a1 L - o Paiient
8z
— 3
a0 — e =
o —
=
78
Clinical |ZED-9508 7 =
T2
E n
88
6
B4
e
80
58
56
£
80
45
46
o 1 2 3 el ] 8 7 8 9 0 11 12 13 14 15 18 17.15 19 20 21 22 23 24
Months.
—_—
T e 1 Show values  |[]
| 7&""“ | CJow rint Graph Type i Cancel Zoom o
To learn more, see the Record physical measurements guide.
Results Inbox now has a side-by-side viewing option.
A new setting in the Clinical > My Options screen allows users to select the layout of the Results Inbox.
To change from the default to side-by-side, select Left to right.
] pefault 1CPC search to show Prablems / Symptams Only
Results Inbox Layout O Top to bottom @ Left to right
Rumber of Problems in My RecentProblems ||OD ‘='.'='| Maximum 100}
P4 Results Inbox - o X
Results Result View Enhanced View
ng 18718 il o 5 Punt (with proter selecton) | 4 Fawigth L Fitpage P zoomin /2 zoomout |k
as P 63 Pont 2ge [P b fouse |
N P T P <] Resmpage [0~ e |
Type |4l | User [Davis, Dr phitip POAVIS
Fatient AssignedTo ResultReparted Date Resut Colleted Date. *Resull ype _ Result Desaition FINAL IVF SCIENCES REPORT
) enorews, jonn Doctor ozmae o2n12018 Resut Coloredtal Cancer Stru
@ runter, Steven  Doctor 021172018 2018 Resut <
L. @ Hunter, Steven Danis, Dr Phillip (PDA... 16/07/2020 15/07/2020 Resuit TESTING RESULT ONE Patient ID# - 306220 Patient
Clinical |ZED-9532 y g R — EMIGasieasa | "Name : Testsumame,Test First Name DOB  1/01/1998  Age at O/C - 24y10
A Jones, s Moriianna- Doctor 22003 2172023 Resutt Cycles 2 - End of aycle
© e s Nortanra. Dot e e Rt Gaees mawoqe | Parner Test Sumame,Test First Name Clnician
@) MOINTYRE Goldie  Davis, Or Philip PDA... 16/10/2021 181072021 Resuit TESTING RESULT FOUI Aetiology ~ Advanced Maternal Age
@ patriot, Mr English  Dodtor 0212008 021172018 Resuit Colarectal Cancer Stru Atk &1 rest PIEEL MEUROURNE IS 8008
Treatment\Stimulation Summary - Cycle #8 - FET+5 Week 47123
LMP = 10/11/2023
Starling FSH dose : BMI 214 U FSH given NIA
Max Oestrogen : 1073 Date U'S  17/11/2023  # Follicies > 11mm -0
Date hCG Time hCG
Endometnial Phase . Proliferative 7.43mm
Thawed 1 Embryos with a 'Virtual OPU" of 17/11/20¢
x
A
=
< »
There are 18 results for <User Roles> < > records 1. 18, ¥
Result Navigation Adtions .
B e | e [ e | [ mtine [ et [0 s | Mo [ cnte || et o et Pk || o Coe

To learn more, see the Results Inbox guide.
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Added Quotes to the Transaction Type of the Transaction/GST Report

Add the option to run the Transaction/GST report showing only Quotes, this does not affect the existing All
function which will still exclude quotes. Note, the Report Summary will be impacted if you include quotes as
there will not be receipts.

Transaction/GST Report
Style Criteria
ISPl Entry Date [28/08/2024 :| = |zafowzoz4 ¢_| B
O Bxtended Details Branch |Test Branch 1 ~|
O summary Account Payer | All “| p
O Other [ .
Treating Doctor | All |
l!:! O Bar e |
M (D Line User Group |All |
& Orie Resource |All ~|
Office ZED-8995 e Transaction Type |All (Except Quotes) ~
ata . All [Except Quotes)
Group By | Mone ~ Transaction Status |peceipts
B Invoices
Sub Group By | MNone e Category |Adjustments
Data Import
Order By Invoice Number ~ Group | gy m_
Mew page on Group By change .PatlentType Staff "Tax Code
All ~ LAl ~ All ~|
To ensure this report includes all transactions Item Description {expiry)
from all other workstations, it is recommended
you exit from all instances of Zedmed Office
running on this workstation and log in again. []3 Professional snendance 2t consulting ro
[ ] 4 professional attendance by 2 general pra
[] 20 Professional sttendance {net being 3 ser
[] 23 professienal sttendznce by 2 general pra
[124 i by 2 genersl pra e
Print Secreen | Export | Show Unallocated Credits [ Help

To learn more, see the Transaction GST Report guide.

Updated Document versioning so it can be turned on or off
Document Versioning is not enabled by default and is enabled in Clinical > Global Option > Letters &
Template tab >-Enable document versioning

Global Options

General Communications  Letters & Templates Scanning Results Drugs  ACIR Immunisation Defaults  Chronic Disease Management  Library

Default Template

Document Template |Ref Letter - Standard | m

Default Letter Subject |

Medications/Prescriptions List
Show Drug Quantity

Pregnancy Module Default Templates

Clinical |ZED-9651

AntenatalTemplate|Pregnancyﬁ.ntenatalRecords |jj

Pregnancy Template |Pregnanty Summary Report | .') ]

Letter Modifications
D Restrict Letter Modifications

[ Enable document versioning

|:| Prefix Subject Line of Qutbound Letters with “Letter” [Default)

? Help [ o || X cancel

To learn more, see the Document versioning guide.
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You can now add a booking time buffer to a practitioner's appointments
A new setting, “Booking time buffer”, has been added to the Doctor Details screen and is configurable by
branch. The value entered is used to refine the available appointments sent to the Online Appointments
(OLA) by only allowing appointment slots that begin after (Booking Time + Buffer).
This prevents people booking online appointments close to the current time
Doctor Details
|dentity Practice
- z
Family Name [l | Dr Code et
- DVA Registered
Given Mames |Ph|l||p | Default Item = l:l REI R:g?;:e::j
OLA ZED-9457 it [wr__| Search HI Service Fee type override =] [aer]
EHealthiD (HPI-]) |m3 6199 0002 6805 | Driype  [Drype
ABN/Bus. Name | | Branches :
Branch | Test Branch 1 =)
AHPRA Number |MEDGDGDDGDGDG | — =
Bank List | Albert Road MC Bank Account [
Home Address 2 g
| | MA Format | General Practitioner |
[ | Frovider # Other Provider # |:|
Suburb | | Claiming Claiming Service Unavailable Delete
I:I Erx Entity ID .Invoice Heade[; Invoice Footer :__)\nother |
Phone Numbers Provider Type ~ [ Available Online
Home Phone | | [ Booking time buffer (in minutes) l:l]
To learn more, see the Online Appointment setup guide.
Reject a patient in the OLA patient reconciliation screen.
When linking first-time OLA bookings to existing Zedmed patients, we have added the ability to remove
provisional patients from the reconciliation process. If the patient already has an Appointment, you need to
Delete their appointment first.
¥4 Online Patient Reconciliation X
OLA ZED_9238 MHame Date of Bir.. Medicare Num... Maobile Phone Address
Gilmour, David | 210571857 | | M491STT6H | 123 Test Street Teshille 3215 |
Jones, Marrianna-Louise 19/05/1967 | 2298038574 0406991730 6 Jones Pl Provisional GOWRIE 2904
R!_fle!h Reconcile Patient
To learn more, see the Reconcile new OLA patient guide.
- Enable printing of multiple TIFF documents as one document
Clinical |ZED-9607 Lo . R . . Lo
In Zedmed Cloud, printing a multi-page image document will no longer result in one print job per page

Resolved issues

Claim and payment reconciliation mismatch

Office | ZED-9642 . . . . - . .
Fixed an issue that caused claim and payment mismatches when reconciling Medicare claims.
Appointment Report AV error when the Referral Details option is selected

Office | ZED-9003 | Fixed anissue that caused the Appointment report to display an error when running it with the Referral

Details option selected.
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Office

ZED-9044

Task Manager displays the same patient for all Tasks Created
The Task Manager screen in Zedmed Office has been fixed to display the correct linked patients in the task
details.

Office

ZED-9062

Unable to save more than 1 new resource at a time
Fixed the issue that resulted in only the first resource being saved when adding multiple resources.

Office

ZED-9063

Fee update error 'ls not a valid floating point value'

Improved the error message shown in Item Fee Update when no value is entered for a percentage or dollar
amount increase. Also fixed the error displayed if Category or Group is selected. Selections will now correctly
filter the items in the list.

Office

ZED-9064

Patient and Find menu items no longer work in the Waiting Room
The Patient and Find Patient menu options in the waiting room now work as expected.

Office

ZED-9349

Internal Mail Merge Template - Unable to Preview and Edit Mail Merge Before Printing
When using internal templates, it is now possible to preview the results of a mail merge and make changes
before printing.

Office

ZED-9375

When adding a new patient, you can't add pronouns until you've saved the patient
Fixed anissue that prevented a pronoun from being selected when creating a new patient in Office.

Office

ZED-9398

The Referral date merge field prints a random date on the Label
Standard patient labels (Internal Template) now print the correct referral date. This corrects a reported error
that some labels print a random date.

Office

ZED-9410

Claim Report missing the Clain ID s8th digit and MBS items 5th digit
Increased space available to display item numbers and claim IDs in the Claim Report.

Office

ZED-9434

Third-Party Account Enquiry allocation Error
Fixed anissue in Third Party Account Enquiry that resulted in an allocation error 400.

Office

ZED-9442

Error 'FireDAC][Phys][FB]Dynamic SQL Error: Too many Contexts of Relation/Procedure/Views. The
maximum allowed is 255'

Fixed a Firebird error that occurred when merging patients from a database that had a considerable number
of Clinics.

Office

ZED-9458

Duplicating schedules does not copy messages correctly
When duplicating or copying sessions on the doctor and resource appointment schedule dialogue, the
schedule messages selected for display in OLA will now be copied.

Office

ZED-9467

Appointment incorrectly removed when cancelling the cancel appointment operation
Cancelling the cancellation of an appointment (at either the reason or linked appointment warning phase) will
no longer remove the appointment from the Select Appointments form listing.
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Office/ ZED-9420 Radiology/Pathology Template download notification pop up.

Clinical The notifications are now displayed when Report templates are downloaded from Office or Clinical,
Unable to Print Results in Alphabetical Order

Clinical |ZED-9018 | Results previewed and printed from the Results Inbox are now in the order, regardless of the column (and
direction) they are sorted on.
Resolved problems with re-prescribing a 'one-off' drug

Clinical |ZED-9081 |Fixed anissue preventing re-prescribing of a one-off drug. Effected new scripts with no drug
name/description.
Spelling mistake in Clinical Observation Pap Smear Result input

Clinical |ZED-9218 | PS nemist ? p>mear P , ,

Inflamitory” has been corrected to “Inflammatory” in the pap smear observation screen - result options.

Results provides no warning when clearing the patient notified date

Clinical | ZED-9384 | oo P gwher gHhepe ) . .
Clinical will now ask for confirmation before clearing the "Patient Notified" date when viewing results.
Access Violation when accessing the Outbox Viewer

Clinical |ZED-9437 | ) & , ,
Fixed anissue that caused an error and did not allow the Outbox viewer to open.
Error 'Must be a numeric value' when modifying observation and measurement value.

Clinical |ZED-9438 |Fixed anissue where an error was incorrectly displayed when an observation value was deleted (for
correction).
Access Violation when clicking the Distribute button in the letter writer,

Clinical |ZED-9439 |Fixan errorthat occurred when Secure Send was enabled but the distribute dialog for letters in clinical was
disabled.
Results Inbox Access Violation error

Clinical | ZED-9532 | Resolved an Access Violation error that could occur when rapidly scrolling through PDF results in the results
inbox.

. Refresh issue when resizing the encounter notes

Clinical |ZED-9637 . . K . .

Fixed a visual corruption that occured when resizing the encounter panel during an encounter.
. Upgrade script failure - Index RDB$PRIMARY 95 already exists

Clinical |ZED-9662 . . . . .
Fixed anissue with upgrade scripts that could cause an error when upgrading some databases.
Document names and versions not displayed in encounter notes

Clinical |ZED-9649 | Fixed issues with the document version, renamed document and duplicated document names not displaying
in Encounter notes. Note: an encounter needs to be running for the note to be written.
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In WP Tools, electronic results do not merge correctly in templates
Clinical | ZED-9675 Fixed an issue where the results merge field was not working correctly when it was part of a table and
ini -
overlapped part of the text. If multiple results are selected they will no longer overlap into the next table in
the template.
Update for Clinical encounter notes issue
Clinical |ZED-9678 |Made an update to address the issues encountered when drawing the text edit field for the current
encounter.
Results showing overlapping text
Clinical |ZED-9693 |t goveriapping ,
Fixed issue where Historical HL7 results show overlapping text.
. Upgraded the wPDF Viewer to the latest version
Clinical |ZED-9697 . L e - . .
This upgrade fixes issues with viewing PDFs containing multiple documents or charts in the Results Inbox.
Summary Views > Results shows overlapping text
Clinical |ZED-9703 | Fixed anissue with some results showing overlapping text in Summary Views Results and Incoming
Documents.
. An AV in CRS_Client error occurs when right-clicking on a referral in the History View
Clinical [ZED-9725 L . . . . .
Zedmed Clinical no longer shows an error in patient history when user right-clicks on a referral.
Don't check for Tyro install on Zedmed startup
Cloud ZED-9241 Updated the way Tyro starts in Zedmed Cloud so if the Tyro Eftpos option in the receipts form is not
ou -
available, you only need to close and reopen the Quickpay> Receipt screen after a short pause. You no longer
have to restart Office.
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